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Preface

Noctar

Noctar is a wide band, high gain, direct conversion quadrature
software defined radio transceiver and signal processing platform.
Using analog and digital conversion, it can capture up to 200MHz of
bandwidth from DC to 4GHz, and rapidly communicate that infor-
mation over an 8Gbps high speed PCIe bus.

Noctar represents our first step towards building a low cost,
distributed, wireless communications infrastructure - something to
enable application developers to implement any wireless device in
software.

Congratulations!

Congratulations on your purchase of the Per Vices Noctar Transceiver!
This manual is intended to provide you with useful information re-
garding the safe operation and use of your new Transceiver. It may
be updated from time to time - you’ll always be able to find the latest
version on the Per Vices website1. 1 http://www.pervices.com

We hope you enjoy using Noctar. In building Noctar, we
aimed to provide a highly capable device at the lowest possible price.
Our belief is that there are significant resource barriers impeding the
widespread adoption of Software Defined Radio (SDR) technology.
These barriers come in the form of the high capital cost necessary
to purchase specialized equipment, and the extensive experience
necessary to successfully operate such devices.

This product is our second step towards reducing the cost barrier.
We’ve tweaked the RF chain, improved shielding, added IO, and
improved performance - in short, we have tried to pack in as much
functionality as possible at a comparatively low price.

Faced with a number of conflicting requirements, we have en-
devoured to satisfy the broadest use cases possible, while trying to
reduce the complexity necessary to operate Noctar. Our goal is to
help you best utilize the flexibility afforded by SDR technology.
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Our hope is that you will find Noctar to be a useful and de-
pendable companion in your engineering, development, and research
efforts.

We welcome your feedback; please feel free to contact us at:
solutions@pervices.com

A note on Langford We originally intended to call our
product φ, but we ended up changing
our name to avoid stepping on toes...
However, to ensure compatibility with
our earlier products, and to simplify
development efforts, we continue to
use ’Langford’ within our drivers and
utilities.

When reading this manual, or using the code examples, drivers, or
utilities, you may come across references to Langford. You may
find yourself wondering who, or what, Langford refers to. The
quick answer is Noctar is part of the SDR series formally known as
φ; for all intents and purposes you can safely assume that Langford

refers to Noctar.



Obligatory Warnings

The following section contains important safety and regulatory infor-
mation. Please pay attention to the following disclaimers, warnings,
and cautions.

This device is intended for engineering, research, or science laboratory use
only - it is not for open office or residential use! This device has not been tested or ap-

proved by any agency or approvals
body for Electrical Safety, Electromag-
netic Compatibility, or Telecommuni-
cations at the time of distribution! You
use this device at your own risk.

Disclaimer

This product is provided «As Is». Per Vices is under no obligation
to provide updates, upgrades, support, or maintenance of any kind.
Per Vices specifically disclaims any and all warranties and guar-
antees, express, implied or otherwise, arising with respect to the use
of this product including, but not limited, to the warranty of mer-
chantability, the warranty of fitness for a particular purpose, and any
warranty of non-infringement of the intellectual property rights of
any third party. Per Vices neither assumes or authorizes any person
to assume for it any other liability.

Your use of this device is at your own risk. Per Vices shall not be
liable for you for any damages, direct or indirect, incurred or arising
from the use of this product. In no event will Per Vices be liable
for loss of profits, loss of use, loss of data, business interruption,
nor for punitive, incidental, consequential, or special damages of
any kind, however caused, and on any theory of liability, whether in
contract, strict liability, or tort (including negligence or otherwise),
arising in any way out of the use of this product, even if advised of
the possibility of such damages.

Product Functionality

Every effort has been made to ensure that the device you receive is
fully functional - each device is fully tested prior to shipping. How-
ever, risk of damage or loss is transferred immediately upon delivery
to you - we do not generally accept returns or refunds on successfully
delivered packages.
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If you have any problems, please contact: solutions@pervices.com

Specifications

Every effort has been made to test and measure the validity of this
equipment. However, we cannot guarantee the accuracy of specifica-
tions, and they may change at any time.

Warnings

WARNING
RISK OF ELECTRIC SHOCK

Do not attempt to modify or touch this device while powered.
Ensure host computer is properly grounded during operation.

Disconnect AC power during installing or removal.

WARNING
HOT SURFACE

This circuit board may become very hot during operation.
Contact should be avoided.

WARNING
LABORATORY USE ONLY

This device has not been approved by any agency or approvals
body for Electrical Safety, Electromagnetic Compatibility, or

Telecommunications at the time of distribution. Research use only!

ATTENTION
OBSERVE ESD PRECAUTIONS

This device contains electrostatically sensitive components: it
may be damaged by static discharges. Observe ESD precautions &
proper grounding when handling, installing, or removing device.
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ATTENTION
RF TRANSMITTER

This device is capable of RF transmission on bands or frequencies
subject to regulatory oversight. Operators are responsible to ensure

use of this device meets local regulatory and legal standards, as
they may apply to you and the band of interest.

This device is intended for test and measurement use only.





Specifications

Noctar is a wide band, high gain, direct conversion quadrature
transceiver and signal processing platform. Using analogue and As Noctar is capable of Digital

Down/Up Conversion, superhet ar-
chitectures can be implemented using
Digital Down/Up Conversion on the
FPGA.

digital conversion, it is capable of processing up to signal bandwidths
up to 200MHz from 100kHz to 4GHz. Noctar is compatible with
GnuRadio, and includes open source drivers.

Absolute Maximum Ratings

Stresses beyond those listed in table 1, Absolute Ratings, may cause
permanent damage to the device. These ratings are stress specifica-
tions only; functional operation of the product at these conditions
is not implied - exposure to absolute maximum rating conditions
for extended periods of time may affect reliability and is not recom-
mended.

Specification min max units

Operating Temperature 5 85 C
Storage Temperature 0 70 C

Input RF Power 15 dBm

Table 1: Absolute Ratings: Ex-
posure or sustained operation
at absolute ratings may per-
manently damage Noctar.
This device is passively cooled
- ensure adequate airflow or
cooling during extended opera-
tion.

Observed Performance

The specifications listed in table 2 on page 15 detail observed perfor-
mance under typical conditions. They are intended as a loose guide
to what we have observed during internal testing; please contact us if
you require specific specifications.

RF Chain

Simulated RF chain performance, based on component specifications,
yield the following simulated performance. As both the receive and
transmission RF chains have variable stages, table 3 on page 16 uses
midpoint references for attenuation and gain stages.



14 per vices corporation

Operating System

We test all devices on a 64 bit Arch Linux system running GnuRadio
and the 3.4 kernel. We do not support the Linux 2.6 kernel. We have
also successfully used Noctar on 64 bit Ubuntu systems.

Some users have reported problems compiling our drivers on
VM’s or 32 bit machines, especially those using Ubuntu, so we rec-
ommend avoiding 32 bit systems or VMs when using our product. During early testing, we suc-

cessfully installed our drivers
on a 32 bit Arch Linux ma-
chine, so it should be possible,
if you’re willing to get your
hands dirty.

Mechanical

A mechanical drawing in included in the Appendix.
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Specification min nom max units

Temperature
Card Operating Temperature 60 C

Analogue
RF Tuning (ADF4351) 35 4400 MHz
Dyn. Range (RX,TX) 10 50 dB

Power Gain (RX, High Stage) @2GHz -23 43 dB
Power Gain (RX, Low Stage) @ 125MHz -4.5 +55.5 dB

Nominal RF Input Power -15 dBm
TX Power (Low) @ 10MHz +15 dBm

Digital
PCIe x4, v1.1 Data Rate (full duplex) 8 Gbps

ADC resolution 12 bits
ADC Sample Rate (per IQ Channel) 125 MSPS

DAC resolution 16 bits
DAC Sample Rate (per IQ Channel) 250 MSPS

Decimation (2n), for values of n=[0,5] 0 32 -
Interpolation (2n), for values of n=[0,5] 0 32 -

Internal Reference (20 MHz)
Frequency Calibration (20

oC) -1.0 1.0 ppm
Internal Frequency Stability -0.28 +0.28 ppm

2)

We use a 5 bit word to set or clear interpolation bits. Decimation or
Interpolation is implemented as a cascade; each stage checks the state
of one of the five bits in the decimation word.
If the bit is set, the stage takes the data and carries out one decima-
tion (or interpolation) by two. If the bit is clear, than the stage simply
passes the information through.
For example, if the interpolation word is set to (TxIntEn = 5’b01011 =
0xb), then three interpolation stages are set (0, 1, and 3), resulting in a
total interpolation of 8 (2^3).
3) I suspect that you’re setting the interpolation stages to 4. This cor-
responds to TxIntEn=5’b00100, which only enables the 2nd stage, and
corresponds to an interpolation of 2.
To help figure this out, you can work backwards, using dd, to help
set the stages. With 0 interpolation, your maximum bandwidth is
limited by the bus (~700MBps), so you’re going to lose packets. How-
ever, with an interpolation of 0xf, you should be able to view the
correct result;
langford_util /dev/langford TxIntEn 0xf
I hope this helps - if I am wrong, and this does not help fix the prob-
lem, please let me know! I’m really eager to help work with you to
fix this.

Table 2: Observed Performance.
These specifications reference
observations taken during in-
ternal use and development.
Please note the Dynamic Range
section for more information.
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Specification DC 2GHz units

Input
RF Input Power -12 dBm

Analysis Bandwidth 100 MHz
Rx Chain

SFDR 63.5 dB
SNR 71.6 dB

Input Rx Sensitivity -73.6 dBm
Input P1dB 1 -7 dBm

Tx Chain
Power Gain 25 14 dB

SFDR 67 71 dB

Table 3: These specifications
are intended to serve as a very
general guide, with variable
gain and attenuation stages set
at midpoints. As variable stages
are adjusted, performance may
vary considerably.



Installation

Installation comprises four steps;

1. Physically disconnecting mains power to your computer and
inserting the card into a PCIe slot.

2. Installing the software drivers and utilities.

3. (Optionally) Copying the initialization routines to a location
where it will automatically load with your computer.

4. (Optionally) Installing GnuRadio2. This allows you to immedi- 2 If you are using ArchLinux, you’ll find
a build script for GnuRadio within the
folder called ’arch’. Use it by running:

makepkg -p gnuradio.PKGBUILD

ately start playing with Noctar.

Physical Installation

Noctar comes in a PCIe form factor, and comes programmed.Turn
off your computer and physically disconnect the AC power cable. If you’re wondering why we’re em-

phasizing the disconnection of mains
power, it’s because we speak from
experience. Learn from our mistakes!

Open up your computer, and install the card in a free x4 (or greater)
PCIe slot. See your computer manufacturer for specific instructions.
Reverse these steps for removal.

Driver and Utility Installation

The installation procedure is relatively straightforward;

1. Obtain a copy of the Noctar drivers. You can download them from
the Per Vices site, or use the ones that may have been shipped with
your device.3 3 We recommend downloading the

latest drivers from:
http://www.pervices.com.2. Run make to build the drivers, then switch to a root user (or sudo)

and run make install.
> cd /langford_driver
> make
> su -l
Password:
# make install

Figure 1: Sample installation
routine; make the drivers, then
install them as root. On Ubuntu
systems, we’ve found compi-
lation sometimes requires root
priviledges (otherwise you get
an error). To get around this,
log on as root prior to running
make, and make install.

This will install the kernel module, and creates the necessary
character device (/dev/langford) which shall be used for RX/TX.

Rarely, make install may fail due to a known race condition (mknod
running before insmod is complete). If this is the case, try running
make install again.

You may encounter permissions prob-
lems. Once everything is set, you
should be able to access and write to
the device with user privileges. If you
encounter problems, chown/chmod as
appropriate and let us know!
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Auto loading Initialization Routines

You will have to initialize the device (by running langford_init) every
time you restart your computer! You can make this easier by copying
this file to your init scripts.

Ubuntu Installation

Ubuntu is not presently supported. Nevertheless, if you’re new to
Ubuntu, here’s a step-by-step guide on getting yourself set up.

There are three to this proceedure: updating your computer and
installing dependencies, compiling and installing the driver, and
running a test script.

Updating and installing packages

1. Open up a new terminal window.

2. Update and upgrade all the existing packages on your computer.

(a) To do this, first we have to update the list of packages, then we
have to upgrade any out-of-date packages. Type the following
two commands into your terminal, and wait for each command
to complete prior to moving to the next one:

$ sudo apt-get update

$ sudo apt-get upgrade

3. We now need to install the linux kernel headers and sources,
along with wget (a command line download program) and gnura-
dio.

(a) In your terminal, type;

$ sudo apt-get install -y linux-headers-generic linux-source

$ sudo apt-get install -y gnuradio wget

4. Reboot your computer.

At this point, we should have updated your computer, and in-
stalled the latest kernel header and source code.

To eliminate the possibility of problems, take this time to reboot
your computer! This will avoid us building a kernel module for an
out-of-date computer.
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Compiling and Installing the langford drivers You may have to re-run the above
commands if you update your kernel.

1. Open a new terminal window, and navigate to your home direc-
tory by typing:

$ cd ~

2. We shall now download the langford driver package. Use the
following command to download the latest driver to your home
directory using wget;

$ wget http://pervices.com/bin/drivers/langford-latest.tar

3. We now need to extract that file, so we type:

$ tar xf langford-latest.tar

This will create a new langford_driver directory in your home
directory.

4. On Ubuntu, we sometimes need to run the commands as root to
avoid possible problems.

(a) Therefore, we’ll generate a root prompt, then enter the direc-
tory we created as root, and compile and install the sources.
The following commands open a bash session as root, enter
the newly created langford_driver directory, and compiles and
installs the kernel drivers.

$ sudo bash

# cd langford_driver/

# make

# make install

Adjusting permissions

The "langford" group is generally created when compiling the kernel
modules, and ensures that your user will have all the permissions
required to modify and use the noctar driver. This group is created to
ensure that only authorized users (that is, users within the group) are
able to configure or transmit on the radio device.

What follows is the procedure to add "langford" as a secondary
group to your user and ensure valid permissions are set.

1. Open a terminal.

2. Associate your user with the langford group (as a secondary
group). If your user name is complicated - for

example, it has a space or funny ascii
character in the name - you may need
to escape the offending character by
placing a ’\’ before the character.

For example, if your username is: "foo
bar", then you’ll have to type "foo\ bar"
whenever we type the user name in our
examples above.

(a) To do this properly, we need to know your user name. If you
don’t know your exact user name, you can find it by opening a
terminal (as a regular user) and typing the following:
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$ whoami

(b) Once you know your user name, we’ll associate it with the
langford group using the usermod command. For example, if
your user name is "foo", we’ll type:

$sudo useradd -G langford foo
This command uses the -G flag to add a secondary group

called "langford" to the username "foo".

3. At this point, we should have resolved any permission errors.
Next, what we’re going to do is ensure that you are able to access
and run all the required files within the langford-driver directory.
This step aims to ensure that any remaining permission errors are
avoided.

(a) To this we’re going to open a terminal and go to your home
directory. Then, we’re going to recursively give your user per-
mission to the langford-driver directory.

$ cd ~

$ sudo chown foo:foo -R ./langford-driver

i. The above code assumes that your username is «foo» - re-
place it with your actual username prior to running the com-
mand.

Initializing the driver + running a test script If you later have problems running or
using noctar, make sure that you’re
properly initialized the device using the
«langford_init» command.

At this point, we have successfully installed the kernel module, and
configured the permissions. An important note is that, prior to run-
ning or using Noctar, we need to initialize it. Therefore:

1. Initialize noctar by running langford_init as root. Type the follow-
ing into a terminal to create the charactor device in /dev/langford
and load the kernel module:

# sudo langford_init

2. Run the langford_rx test script (found within the langford_driver
directory).

To do this, enter the langford_driver directory (in our case, that
was in ~/langford_driver), and enter the test directory. Using the
above proceedures, this should be found in your home directory:

$ cd ~/langford_driver/test $ ./langford_rx_500MHz.sh

3. This should bring up a command that configures the langford_device,
and brings up a gnuradio-companion interface with a graph al-
ready created. To use it, you’ll have to generate and execute the
flow graph.
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(a) To generate the flow graph, either press the ’F5’ key, or use
’Run > Generate’ from the top drop down menu.

(b) To execute the flow graph, either press the ’F6’ key, or use
’Run > Execute’ from the top drop down menu.

This should bring up a nice waterfall plot to demonstrate that the
receiver is working.

Running the FM Rx demo

1. We’re first going to download and extract the required files and
flow chart. To do this, we shall enter into the langford_driver
directory (presumably stored in your home directory, download
the latest version, and run it):

$ cd ~

$ cd langford-driver

$ wget http://www.pervices.com/bin/fmrx.tar.gz

$ tar -xf fmrx.tar.gz

2. This should create a langford-fmrx directory that includes all the
relevant files and scripts required. To take a first stab at it, we’ll
enter into the langford-fmrx directory and run the first demo
script, and see whether it works off the bat. On Ubuntu, you may
have to run the configuration command as root - this is to ensure
that only authorized users can actually tune the radio front end.
You also need root permissions to send to the radio transmitter.

$ cd ./langford-fmrx $ sudo ./langford_fm_prep.sh

3. The langford_fm_prep.sh script is a bash script that calls a number
of other command line parameters (namely to the langford_util
command line program) to correctly tune the receiver, and config-
ure it for operation for the FM demo script.

This command should have brought up the flowchart that de-
scribes the dual-channel FM Rx radio receiver.

(a) To generate the flow graph, either press the ’F5’ key, or use
’Run > Generate’ from the top drop down menu.

(b) To execute the flow graph, either press the ’F6’ key, or use
’Run > Execute’ from the top drop down menu.

In most cases, this is enough to generate a waterfall plot which
shows the local FM stations. By default, both channels are muted,
but you can independently adjust the volume and tuning fre-
quency for each channel.



22 per vices corporation

Troubleshooting the FM Rx demo

SOMETIMES... just running the above is not enough. If you live in a
distant area, or perhaps you just see a blue screen, you’ll may have to
adjust the dynamic range of the plot, or tune the radio stage.

If all you see is a blue screen, you may need to calibrate the water-
fall plot.

1. To do this, click on the "Autoscale" button found on the right
side of the waterfall plot. This adjust the window function to the
maximum and minimum signal strength found on your graph.

But wait!!! Sometimes, radio’s being what they are, things will still
not work! If that’s the case, it’s likely we’ll have to play with the
radio stage...

Adjusting the radio front end

Adjusting the radio front end takes some practice... There are a num-
ber of different stages, and picking the "best" parameters for your
application takes some trial and error, so a little patience is required
to get the hang of things...

1. To adjust the radio front end, we’ll use the noctar IO utility. We
shall open this utility, in a separate terminal, while the first wa-
terfall plot is running. This utility shall allow us to configure the
radio front end. To open the utility, we’ll need to enter the lang-
ford_driver directory, and execute the correct file;

$ cd ~

$ cd langford-driver

$ sudo ./noctar_io/pv_noctar_io.py

2. Running the python script above should bring up a (somewhat
complicated-looking) window that allows you to easily run various
commands. It’s best to position this window slightly to the side of
the waterfall plot, so you can easily see both the running waterfall
plot, and the GUI utility.

3. Next we’ll try to maximize the gain. Our intention here is to com-
pletely saturate the radio front end, after which we’ll back off and
try to find a setting that maximizes our visibility into the signal
without compromising dynamic range.

(a) The first thing we need to do is make sure that we update
the script with the correct frequency and decimation settings.
Therefore, for the receive stage block, we set:
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i. Frequency: 97.5e6

ii. Decimation: 16

This corresponds to a capture bandwidth of 15.625MHz cen-
tered about 97.5MHz.

(b) Now, we’ll saturate the amplifiers. Because we’re in RF mode
(above 50MHz, we recommend using RF mode), we only need
to adjust the RF parameters. We shall first maximize the RF
gain, and then maximize the VGA driver gain. To do this, set:

i. RF Gain: 255

ii. VGA Gain (I): 63

iii. VGA Gain (Q): 63

(c) Now, we’ll hit "Apply" in the Noctar IO panel to actually write
those settings to the device.

4. Having updated the radio parameters, click on "Autoscale" again
to rescale the waterfall plot.

5. At this point, if everything went well, you should see a number
of red bands that looks like a receiver in saturation. This should
serve to convince you that something is happening... To figure out
exactly what that something is we need to back off the gains - first
the VGA gain, then the RF gain - to get something less saturated.

(a) Reduce both the VGA Gains by half (midpoint, about 32), and
hit apply again.

See if this improves the signal quality (reduces saturation), and
if you can tune into a radio band.

(b) Reduce the RF Gain by half, and hit apply.

See if this improves the signal quality (reduces saturation), and
if you can tune into a radio band.

6. If you’ve managed to reduce saturation of the Radio stage, then
try increasing the VGA gain to better pick up a weak signal. If
you’re having trouble tuning in at all, you may have to adjust the
RF to better capture the signal prior to bringing it to baseband
where the VGA gain can boost it.

It’s a little bit of a tricky game, and there are some gotchas for the
uninitiated (for example, the band you see in the middle is caused
by the DC offset - it’s a conversion artefact, which can be filtered out
in hardware if required), but you should be able to get the swing of
things in time.
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GnuRadio

The easiest way to start using Noctar requires you to have a com-
plete GnuRadio installation. GnuRadio may be including in your
distributions package manager. If you want to use the utilities, en-
sure that you pay special attention to satisfying all necessary (and
optional) dependencies.4 4 Some good initial tests of whether

things are working properly can be
found using the scripts in the tests/
directory.



Troubleshooting

First, ensure that you’ve initialized the driver;

# langford_init

It may be necessary to rebuild the langford drivers after updating or
upgrading your kernel. If you encounter runtime errors indicating
the file doesn’t exist, ie;

failed to open ’/dev/langford’: No such file or directory
Runtime Error: can’t open file

Then you may have to initialize the character device, using the lang-
ford_init script;

#langford_init

If something’s not working, confirm that the computer detects the
card and has loaded the correct module;

$ lspci |grep Altera -A9

XX:YY.0 Unassigned class [ff00]: Altera Corporation Device 0004

(rev 01)
Subsystem: Altera Corporation Device 0004

Control: I/O+ Mem+ BusMaster+ SpecCycle- MemWINV- VGASnoop-
ParErr+ Stepping- SERR+ FastB2B- DisINTx-

Status: Cap+ 66MHz- UDF- FastB2B- ParErr- DEVSEL=fast >TAbort-
<TAbort- <MAbort- >SERR- <PERR- INTx-

Latency: 0, Cache Line Size: 256 bytes
Interrupt: pin A routed to IRQ 16

Region 0: Memory at fbcf0000 (32-bit, non-prefetchable) [size=64K]
Region 1: Memory at fbcec000 (32-bit, non-prefetchable) [size=16K]
Capabilities: <access denied>
Kernel driver in use: langford

The important points are that the card exists and your detects it
(evidenced by the fact you get this output), and that it has loaded
the correct driver (evidenced by the last line, «Kernel driver in use:
langford».

If you don’t get this output, confirm the card is properly inserted
into the computer.
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If you don’t see the langford kernel driver, confirm that you’ve
installed the driver properly.

Remember; you need to load the driver using langford_init prior
to using the card!

Tuning the Card

If you’re unable to see anything on the waterfall plot, or if your out-
put is saturated, you may need to adjust the radio gain. You may
do this using the command line, or through the Noctar IO panel.
More information on this utility is available in the Graphical Utilities
chapter on page 29.

You may use this utility to adjust the radio chain settings of the
card in real-time: but try and ensure that you’re properly setting the
frequency and decimation to match your application!



Command Line Utilities

This section discusses the utilities available to read and write data
from Noctar, how to use the control utility, and an illustration of the
python IO application.

Command Line Utilities

Multiple command line utilities are used to control the functionality
of the Noctar device. We describe these utilities here.

Location of Utilities

These utilities exist in two locations:

1. langford_driver

2. langford_driver/libs

Building the Utilities

For both locations (langford_driver, libs), a straightforward make,
and make install should work.

Types of Utilities

In general, all utilities can be sorted into 3 categories by level of ab-
straction:

1. Raw register access – langford_util

This is the lowest level of abstraction. This utility allows you to
manipulate the hardware registers on the PCIe device directly.
This utility only accepts raw values (e.g. on/off) and does not
perform any computation. This utility is useful for debugging
where the finest control is required5. 5 A detailed list of the parameters,

including net names, allowed values,
and descriptions, can be found in the
Driver Implementation section of
this guide.

2. Serial protocol manipulation – langford_driver/test/langford_*_util
This is the second lowest level of abstraction. These utilities al-

low you to write values to serial interfaces (e.g. to the frequency
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synthesizer), abstract the bit banging, and automatically config-
ure on board chips. These utilities are also useful for debugging
the calculation of values for the serial interface peripherals. For
example, to debug the frequency synthesizer, you can use lang-
ford_adf4350_util to write the register values in 32 bit hex values
directly as a program argument. The utility takes care of toggling
all the appropriate bins necessary to perform the serial data trans-
fer. Remember that hex values start with 0x.

3. Task oriented – libs/langford_rx_rf_bb_vga, libs/langford_RX_bb_vga,
langford_adc_util

These are the next level up in abstraction. These utilities calcu-
late the raw values based on target parameters and program the
appropriate peripherals. For example, you can use fsynth to set the
frequency synthesizer to a certain frequency. fsynth calculates the
register values for the peripheral and toggles all the pins necessary
for serial data transfer.

4. GUI wrappers - noctar_io/pv_noctar_io.py
These utilities provide a GUI wrapper to some of the lower level

utilities.

Using Utilities

If you run any of these utilities without any arguments, a help mes-
sage will be displayed. Typically, these utilities will require the name
of the character device (/dev/langford by default). For example, to
tune the RX RF stage to 500MHz, you can run:

./langford_rf_fsynth /dev/langford 0 500e6

A complete listing of parameter options and legal values is in-
cluded in the Driver Implementation section.



Graphical Utilities

There are two graphical utilities; a configuration GUI, and some
gnuradio companion scripts to get you started.

Noctar IO GUI

To illustrate how everything works, we’ve developed a python GUI
that allows you to easily adjust the options available to you. Figure 2

on the following page shows a screen shot of the utility program. The
source code is available for reference.

When playing with the FM Rx Demo, you may want to also launch
the Noctar IO panel in order to adjust the gain settings. Remember
to correctly set the decimation and frequency in the NoctarIO panel
settings prior to applying any settings - otherwise the flow chart will
not work properly! The noctar IO panel is included

in the langford_driver pack-
age with a relative location of:
./noctar_io/pv_noctar_io.py

GnuRadio Integration

If everything has gone well, you should be able to run scripts in the We need the following things to fall into
place; physical installation, software
driver installation, driver initializa-
tion (run langford_init to create the
/dev/langford device), and a working
gnuradio installation.

test folder. These scripts automatically tune the front end, and launch
an example gnuradio script. This allows you to immediately start
playing with the device, as shown in Figure 2 on the next page.
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Figure 2: Screen capture of
Noctar GUI controlling the re-
ception of a simple GNU Radio
Companion flow chart.

Figure 3: Screen capture us-
ing GnuRadio Companion,
and Noctar IO panel to view
waterfall plot.



Usage Notes

Receive Chain

• This device is capable of very high gain - you might find yourself
saturating or overload the receiver. This can be easily solved by
turning down the gain. The RF Front End has about 40dB

dynamic range at the RF Attenuators.
• If you are working with the High branch, look at whether the

IQ channels are balanced using a scope view (our test directory
contains this). If not, you can adjust each RX VGA channel inde-
pendently.

• You can implement very reasonable Automatic Gain Controls
using the RX Base band VGA controls. One day, we hope to push automatic

gain controls to the driver, along with
IQ balancing.• Later revisions of the device interleave the ADC samples to pro-

vide a real valued, base band signal, at 250MSPS with anti aliasing
filters with a 110MHz cut off. This effectively provides base band
scope functionality, at the expense of giving up DSP (so no FPGA
down or up conversion). This usually works out well, as you can
implement batch applications to collect and filter data (includ-
ing down conversion and decimation) in software, over the PCIe
bus, without necessarily compromising anything. If using the
base band stage, pay attention to the Receive Data (Base band

Branch) section on on page 59.

• You can adjust the ADC gain. By default (power on), both ADCs
are automatically configured to digitize a 2Vp-p signal. However,
with the introduction of this new feature, you can adjust the full
swing ADC input from 1-2Vpp. This may be configured in 1dB
steps, from 0 to 6dB. This may be useful in achieving better IQ
balance.

– For example, to adjust ADC A, use the Langford ADC utility,
and run the following command;

langford_adc_util /dev/langford A IntRef 2

The A refers to ADC A which digitizes the Q signal component
(choose ADC B for the I signal). The 2 specifies 2dB of gain on
the apparent signal swing.
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– When you want to turn off this feature to the default 2Vp-p,
pass in -1 as the last parameter;

langford_adc_util /dev/langford A IntRef -1

– There is a catch; you may have to remove RC10. It was origi- If you suspect this is a problem,
contact us and we’ll guide you
through it.

nally placed in to act as a short which improves matching and
balance between I and Q.

• At full RX bandwidth (no decimation), you may sometime lose
bytes under GNU Radio, especially with waterfall plots. This is a
large problem for RX since integer sizes are 16 bits. A loss of 8 bits
will cause incomprehensible data corruption (because you’ll only
have the latter half of a sample). Increasing decimation generally
avoids the problem on lower end hardware.

Constraining ADC Output

It may sometimes be useful for you to constain the ADC output -
at the ADC itself. For example, you’ve developed some neat FPGA
code, and would like to confirm that your FPGA logic is correctly
handling inputs. Perhaps you don’t have an signal generator, and
would like to have a known input at the ADCs.

We can use the langford_adc_utility to program the ADC’s to
output test pattern outputs. To do this, we need to write to address
0x0014h of the appropriate ADC with a single additional byte. The
value of this byte, along with some other neat tricks, may be found
in Table 26 of the ADC1210S series 12-bit ADC data sheet. For con-
venience, we’ve reproduce the relevant table in Table 4 on the next
page.

What this essentially means is that to set the output of ADC B to
its midpoint, we type the following;

langford_adc_util /dev/langford B Raw 0x1401

Alternatively, to set the output of ADC A to its maximum value, we
type;

langford_adc_util /dev/langford A Raw 0x1403

After you’ve finished playing with ADC A, you can set it back to
normal by typing;

langford_adc_util /dev/langford A Raw 0x1400

You may find more commands and ADC fine tuning in the user man-
ual - including how to use these codes for digital offsets, or timing
correction (adjusting for IQ mismatch), in the datasheet.
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Bit Symbol Access Value Description

7 to 3 - 00000 not used
2 to 1 TESTPAT_SEL[2:0] R/W digital test pattern select

000 off
001 midscale
010 -FS (Full Swing) (MIN)
011 +FS (Full Swing) (MAX)
100 toggle ’11...11’/’00..00’
101 custom test pattern
110 ’1010..1010’
111 ’010..1010’

Table 4: Test pattern register 1

(address 0x0014) bit descrip-
tion. From the ADC1210S series
datasheet (NXP Semiconductors
/ TI).

Transmission

• There is a race condition that sometimes manifests itself when
writing to the driver. We’re not yet sure what, exactly, is happen-
ing, but sometimes when you start writing to the device, you get
garbage output. This only seems to manifest after the TX branch
has been used, and we’re still trying to isolate the problem. In the We think the problem may relate to

how the DMA transfer is completed -
a byte may be getting dropped some-
where.

meantime, to fix the problem, type the following:

$ langford_util /dev/langford TxDspEn 0

Places the Tx DSP chain in reset (output will stop).
$ langford_util /dev/langford TxDspEn 1

This takes the Tx DSP out of reset (output will resume).

• There is no VGA on the DAC outputs; If you want to balance IQ
output, do so (in software) by adjusting the phase and amplitude
of the I/Q signal going into the DAC.

• The low frequency stage is attached to a single DAC output (you
can’t interleave DAC outputs). The other channel is dangling, but
you may access it by directly probing the two exposed test ports,
shown in 4 on the following page.

Driver Notes

• If you are running into a permission denied problem when access-
ing the character device, use chmod or chown to set the permis-
sions appropriately.

Full Rate Transception

• At full bandwidth (no decimation), some computers have trouble
running GNU Radio without dropping bytes, especially with
waterfall plots. This is a problem as we use 16 bit integer sizes
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Figure 4: These test points
(found about the top left corner
of the shield that is immedi-
ately to the left of the DAC)
directly access the second DAC
channel while in baseband
mode.

- dropping a byte (8 bits) irrevocably corrupts data. If you find
yourself encountering this problem, increase the decimation to 2 or
higher will avoid this problem.

Decimation and Interpolation

We use a 5 bit word to set or clear decimation and interpolation bits.
The actual decimation or interpolation is implemented as a cascade;
each stage checks the state of one of the five bits in the decimation
word. If the bit is set, the stage takes the data and carries out one
decimation (or interpolation) by a power of two. If the bit is clear,
than the stage simply passes the information through to the next
chain.

For example, if the interpolation word is set to (TxIntEn = 5’b01011

= 0xb), then three interpolation stages are set (0, 1, and 3), resulting
in a total interpolation of 8 (2^3).

• Make sure that you use hex when specifying the number of deci-
mation or interpolation bits you want to set. To set a decimation of
8, you need to set three bits;

langford_util /dev/langford TxIntEn 0xb

• To conserve FPGA resources, decimation and interpolation are cur-
rently implemented for powers of two from zero to five (2n, where
n ∈ N0, 0 ≤ n ≤ 5) , where n corresponds to the number of bits set
in the decimation or interpolation register6. The decimation values 6 Referencing the langford_util io

program, the decimation register is
implemented as RxDecEn register, and
interpolation as TxIntEn.

are implemented as a five bit block; for every bit that is enabled,
another factor-of-two decimation stage is introduced to the signal
chain.
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• To calculate Receive sample rate, after decimation, use the fol-

lowing formula; frx,SR =
Fsample,adc

2n , where FADC,SR = 125MSPS.
To illustrate, if you seek to reduce the sample rate by a factor of
8, three bits of decimation would be set (n = 3), such that the Three bits of decimation correspond to

setting RxDecEn = 0x7.ultimate sample rate is, Fsample,adc =
125MSPS

23 = 15.625MSPS.

• To calculate transmission sample rate, prior to interpolation,
use the following formula; ftx,SR =

FDAC,SR
2n , where FDAC,SR =

250MSPS. As above, if you want to send data at 62.5MSPS, you
would set 2 bits of interpolation (n = 2), the sample rate works out Two bits of interpolation require setting

TxIntEn to 0x3.to be; Fsample,adc =
250MSPS

22 = 62.5MSPS.

Benchmarking Throughput

• You can figure out the maximum sustainable transfer rates by
using dd;

$ dd if=/dev/langford of=/dev/null bs=4092

$ dd if=/dev/zero of=/dev/langford bs=4092

• Due to the character device buffer, transfer rates reported by
dd may not be perfectly accurate due to the overhead in flush-
ing/filling the buffer and waiting for remaining DMA transfers to
complete. For RX, the reported transfer rate will be less than the
actual transfer rate. For TX, the reported transfer rate will be more
than the actual transfer rate. Running dd for a longer period of
time will yield on more accurate results, ultimately, converging on
the correct answer.

DMA Transfers

• DMA read and write bandwidth over the PCIe bus is not symmet-
ric. Write bandwidth is larger since writing to system memory is
a “fire and forget” event. When data is sent over the PCIe bus, it
is assumed to have completed successfully. Reading from system
memory requires the writing of a read command and waiting for
the data to come back, leading to lower bandwidths.

• Are the input I and Q appearing incorrectly in user mode appli-
cations? Do you get base band signals that are exactly the neg-
ative of the frequency of what you expect? This is easy to fix,
find the following line in langford_system.v: .iAdcDI(iAdcAD),
.iAdcDQ(iAdcBD), And change them to: .iAdcDI(iAdcBD), .iAd-
cDQ(iAdcAD), The same logic applies to TX and the DACs.

• If you decide to add a SignalTap instance to the top level design,
you might have to disable either the RX or TX DSP chain to free
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up some resources. This is easy to do while maintaining system
(software, driver & RTL) integrity. Look for the null sink or the
null source commented out near the FIFO and DSP chains. Simply
replace the FIFO and DSP chain with the null source/sink.

FPGA Code

• The top level Qsys file needs to be modified slightly after its au-
tomatically generated. There is a known issue with Qsys where
signals cannot be used both inside the Qsys design and exported
form it simultaneously. There is nothing conceptually or practi-
cally wrong with doing so, but it is not supported by Qsys, hence
this must be done manually.

– Open the langford_qsys/synthesis/langford_qsys.v file.

– Remove the line:

* wire pcie_hard_ip_0_pcie_core_clk_clk;

– Find the line:

* module langford_qsys (

– Add the following line immediately after the line that you
found above:

* output wire pcie_hard_ip_0_pcie_core_clk_clk,

• When building the FPGA image, you may encounter timing er-
rors. There are multiple false paths between the GPIO pins (PCIe
clock domain) and ADC/DAC pins which are on different clock
domains. These are false positives and can be safely ignored.



System Overview

Overview

Noctar has independent RX and TX chains. Within each chain,
there are two branches, a High branch, supporting RF frequencies
(generally about 150-4000MHz), and a Low branch, supporting base
band applications (usually from several hundred kHz through to
110MHz). Figure 5 broadly describes the RF chain (along with rele-
vant device information) for the RF System.
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Noctar GPIO

Noctar has ten user assignable IO pins. These pins, accessible The inputs are directly coupled
to the FPGA - if you’re not care-
ful about what you attach, it
may very well be the last thing
you attach.

through an IO header protruding from the bracket, allows you to
build programs capable of communicating with outside equipment.
By default, we assign pins 1-5 as inputs, and pins 6-10 as outputs.
The pin numbering system is shown in Figure 6.

Figure 6: Noctar IO header pin
out.

Warning

These pins connect directly to the FPGA - be really, really, careful
about what you plug into the ports, and ensure it meets with the IO
standards you’ve specified.

Default IO Standard

By default, all user access able GPIO pins on the header use a 2.5V
IO standard.

Reading and Writing to IO

You can read, and set, the state of the GPIO pins using the langford
utility.

$> langford_util /dev/langford GPIOin
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The inputs (pins 6-10) are weakly pull-up, so without anything to
pull them down, the default state should be high.

Modifying the IO Pin Configuration

So you’re all set with the next big thing... But you just need a couple
more pins - maybe you aren’t using the outputs, and really want to
convert some of the IO inputs into outputs.

With Noctar, this is easy! There are two parts to this - adding the
pins to the FPGA, and including them in the driver.

FPGA Modification

Follow these instructions: More information on the FPGA con-
figuration may be found in the FPGA
implementation section.1. Download and install Quartus II 12.0 SP2

7

7 You can download Quartus II
gratis from the Altera website -
https://www.Altera.com

2. In Quartus, click File > Open Project.

3. Select and open the langford_system.qpf project file.

4. Choose any bit(s) that is available on any PIO register. Reference
the FPGA implementation section for assigned PIO pin outs.

(a) Pretend you choose Lets say you choose bit 18 on PIO0 (output
only), with the name oTestPin.

5. Choose an appropriate register based on the direction of the data,
PIO2 can be used for input only, all other registers can be used for
output only.

6. Open the langford_system.v file.

7. Find the line:

module langford_system(

8. Add the following line immediately after it (change output to
input if necessary):

9. output oTestPin,

10. Find the line:

endmodule

11. Add the following line immediately before it you are adding an
output pin:

assign oTestPin = wPIO5[22];

12. Alternatively, if this was an input pin, this would work:

assign wPIO2[5] = oTestPin;

13. Click File > Save.
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14. If this is a pin internal to the FPGA, then continue and make
any other changes to the FPGA design as necessary. The remain-
ing steps except for the last are not necessary. If this pin is to be
accessed outside the FPGA, follow the remaining steps.

15. Click Processing > Start > Start Analysis and Synthesis.

16. When the process has complete, click Assignments > Pin Planner.

17. Find the pin that you just added in the list. For the Location
column, enter the pin number that you want the signal to appear
at. Modify the I/O Standard as necessary.

18. Add the pins to the FPGA design.

19. Follow the driver instructions in the Driver Implementation
document to add driver support to these pins.

Driver Modification

1. Add a new IOCTL_GET and/or IOCTL_SET definition to lang-
ford_ioctl.h. Ensure that the numerical value hasn’t been already
been assigned. IOCTL_GET commands are for reads, IOCTL_SET
commands are for writes. If you have read only or write only pins,
you only have to define one and not the other.

2. In langford.c, there are two switch blocks. The first switch block
defines the offsets for the pin. The second switch block performs
the actual IO. Modify the 2 switch blocks in the following fashion:

(a) Add the IOCTL commands to the first block together. Assign
the AddrOffset variable to the appropriate Avalon-MM memory
address that you set for the GPIO peripheral in Qsys.

(b) The second switch block is grouped by data access width.
Some pins are accessed 1 bit at a time. Others may be accessed
as 8 bit bytes or even 32 bits at once. There are different groups
for reads and writes. Find the appropriate group for your pins
and add your IOCTL commands to them.

3. Add the pin to langford_util.cpp. There 2 to 3 places which you
have to modify:

(a) Add the pin name to the help message

(b) For pins which can be read, add a new else if statement to the
read handler which has the pin name which you put in the help
message and the appropriate IOCTL_GET command.

(c) For pins which can be written, add a new else if statement to
the write handler which has the pin name which you put in the
help message and the appropriate IOCTL_SET command.





On Latency and Performance

If you’re reading this section it’s because you’re likely pushing
boundries, or trying to accomplish something very neat. The de-
fault firmware uses very conservative settings, so we encourage you
to tweak the settings to significantly improve your particular applica-
tion8. 8 We really want to encourage you to

get the most out of our hardware, so
please don’t hesitate to contact us if
you have any questions, or face any
problems, in getting the most out of
your hardware.

The following section aims to provide you with the background,
tools, and suggestions you can use to really get the most of what we
offer.

Some of the things we talk about may
seem daunting - but don’t be put off.
Try a couple of things, and if you’re
stuck, please don’t hesitate to contact us
for help!

Latency

We provide a complete test bench of the entire DSP chain. This test
bench indicates that, after considering DMA unpacking, filtering,
digital up or down conversion, and decimation and interpolation, the
default latency is about 1ms.

Importantly, this latency doesn’t reflect the capabilities of the hard-
ware - much of this is based on digital up and down conversion
(using multipliers), and the decimation and interpolation filters.

If you have a specific frequency of interest, you can choose to
either implement an «IF» architecture using a fixed digital up or
down conversion. You may also choose to replace the decimation or
interpolation blocks with a filter of your own design.

Finally, for ultra-low latency, you might opt to remove the entire
DSP chain, and carry out all processing on the host computer - dras-
tically speeding up the entire process, and likely improving routing
and timing9. 9 If you decide to pursue this approach,

let us know - we’d love to see whether
we can help you out.

DMA Transfers

The current driver uses a sub-optimal version of memcopy to im-
plement the DMA transfers10. Fixing this would likely improve sus- 10 This shouldn’t be too hard, but

requires a good understanding of linux
device drivers and PCIe interupts -
we’re working on it...

tained transfer rate, and possibly latency.
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IQ Matching

If you’re looking at this section, it’s likely because you’re looking at
trying to get the most performance out of the board. You might even
be asking yourself - why did you guys use two discrete ADCs?11 11 The answer comes down to cost -

we’re trying to pack in a lot of per-
formance while still keeping the price
low.

How do I match them?
You’re looking at two different problems - ideally, we want to

match the amplitude, and phase at the ADCs.

Amplitude Matching

If you’re working on the high frequency branch, you’ll notice that we
have two seperate differential VGAs: one for the ’I’ component, an-
other for the ’Q’ component. This allows for independant adjustment
of the I and Q amplitudes prior to hitting the ADC.

You can also adjust the attenuation, within the ADC, by using
the langford_adc_utility. This has the impact of changing the full
swing potential on the ADC to between 1-2V. To set the fullswing
attenuation on ADC A to 1V, type the following;

langford_adc_util /dev/langford A IntRef 0

You can disable this, and revert to the default behaviour, by typing:

langford_adc_util /dev/langford A IntRef -1

If you’re feeling super adventurous, there’s even room for a small
resistive attentuation network just past the prior to the ADC.

Finally, you might adjust the amplitude of each channel by modi-
fying the FPGA firmware. There’s a convienent location just after the
high pass filters in the verilog code.

Phase Matching

So here it becomes a little tricky. We suggest implementing an IQ
correction filter in software - we’re working on building an example
implementation - which would allow you to artificially delay one (or
both) of the wave forms.

To Be Continued...

We’re likely going to add more to this section once we have a chance
to catch our breath. If you have any questions in the meantime,
please don’t hesitate to contact us.



FPGA Implementation

Your most excellent choice of the Noctar Transceiver means that
you’ll have access to the FPGA firmware under a noncommercial
license12. 12 If you’re looking for a commercial

license, please don’t hesitate to talk to
us. We’re open for business!

The FPGA firmware is written in Verilog, and uses a combination
of Per Vices custom IP, and generated IP from Altera.

Convention and Directory Structure

The top level directory contains two reasonably important directo-
ries:

system This is top level system directory. It contains the contains
the main Quartus project file, along with the top level
verilog including the Quartus Megafunctions, and the
Altera PCIe hard IP.

dsp This is the DSP directory - it contains all the Per Vices
IP necessary to implement the decimation, interpolation,
filtering, and digital down/up conversion. This directory
includes a complete testbenches simulating the entire dsp
chain using iVerilog.

We now discuss each section in turn.

System - FPGA System

The FGPA system comprises of the following modules:

1. langford_qsys – main Qsys design

This design contains the Altera Qsys modules, including the PCIe
hard IP (HIP), DMA controllers, and GPIO controllers. This block
can be edited with a point and click GUI. To open it, complete the
following steps:

(a) Download and install Quartus II 12.0 SP2, ensuring that you
install all necessary modules for the Cyclone IV series. You can
download it from: https://www.altera.com
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(b) In Quartus, click File > Open Project.

(c) Select and open the langford_system.qpf project file.

(d) Click Tools > Qsys

(e) Qsys will prompt you to open a system. Select and open the
langford_qsys.qsys file.

(f) You can now view the connections which make up this module
and make changes as you see fit.

2. DcFifo64 – 64 bit dual clock FIFO

This module serves as extra buffer space as well as clock do-
main synchronization. The ADC and DAC operate on different
clocks than the DMA controller on the FPGA. The FIFO serves as
a clock domain crosser for the data which is stream from/to the
ADC/DAC and the PCIe DMA controllers.

3. TopRx – rx DSP chain

All DSP performed on the FPGA for incoming data from the ADC
is performed in this module. A detailed description can be found
in the DSP Used in Phi document.

4. TopTx – tx DSP chain All DSP performed on the FPGA for outgo-
ing data from the DAC is performed in this module. A detailed
description can be found in the DSP Used in Phi document.

5. pcie_gx_reconfig – PCIe self reconfiguration block The Altera PCIe
HIP has the capability to reconfigure its electrical properties to
suite the host computer. This includes automatic equalization and
preemphasis. This module controls this functionality.

A diagram detailing the FPGA system is shown in Figure 7.
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wRxData
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w
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X
R
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_*
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oPCIeTx

iPCIeRx

PCIe clock domain

DAC clock domain

ADC clock domain

Figure 7: Noctar FPGA sys-
tem. Control signals have been
omitted for the sake of clairity.
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DSP - Digital Signal Processing System

We use several DSP cores to deliver you the magic of SDR. Each DSP
core occupies its own subdirectory in the dsp directory, with multiple
DSP cores being integrated into the rx and tx DSP chains. The rx
DSP chain is called TopRx and the tx DSP chain is called TopTx. Each
chain is comprised of smaller DSP cores, chained together as building
blocks. Let’s take a closer look at how the Rx and Tx chains work...

Rx DSP Chain – TopRx

The Rx chain, shown in Figure 8, comprises of the following mod-
ules:

HPF
HPF_I

HPF
HPF_Q

iADCDI ComplexMult
ComplexMult_0

iADCDQ

wHpfI

wHpfQ

SinCosNCO
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Decim2CIC
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Decim2CIC
Decim2_Q1 2
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wQ2

Decim2CIC
Decim2_I3 2

Decim2CIC
Decim2_Q3 2

wI3

wQ3

Decim2CIC
Decim2_I4 2

Decim2CIC
Decim2_Q4 2

wI4

wQ4

Decim2CIC
Decim2_I5 2

Decim2CIC
Decim2_Q5 2

wI5

wQ5

Data
packing

oDmaStreamData

Figure 8: The TopRx Signal
chain. Flows left to right, with
control signals omitted.

1. HPF – high pass filter

The high pass filter removes DC offset. Cut off frequency is ~30

kHz when sampled at 125 MHz.

2. SinCosNCO – sine and cosine numerically controlled oscillator

This NCO produces the signal required to perform digital down
conversion. The output of this module is always synchronized at
90º apart.

3. ComplexMult – complex multiplier

The complex multiplier takes two complex numbers and calculates
the product, also a complex number. This performs digital IQ
down conversion.

4. Decim2CIC – optional CIC half band filter and decimate by 2
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This module allows for optional decimation by 2. This allows for
lower digital transfer rates and narrower signal bandwidths while
avoiding problems relating to aliasing.

Tx DSP Chain -TopTx

The Tx chain, shown in Figure 9, comprises of the following modules:
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SinCosNCO
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Figure 9: The TopTx Signal
chain. Flows right to left, with
control signals omitted.

1. Interp2CIC – optional interpolate by 2 and CIC half band filter

This module allows for optional interpolation by 2. This allows for
lower digital transfer rates and narrower signal bandwidths while
avoiding problems relating to harmonic spurs.

2. SinCosNCO – sine and cosine numerically controlled oscillator

This NCO produces the signal required to perform digital up
conversion. The output of this module is always synchronized at
90º apart.

3. ComplexMult – complex multiplier

The complex multiplier takes two complex numbers and calculates
the product, also a complex number. This performs digital IQ up
conversion.



FPGA Simulation and Test bench

Verifying DSP Cores

Each DSP core can be tested separately or together. Two types of
types of tests are done on each DSP core, each with their own pur-
pose:

1. Simulation Quick results for ease of verification Used to check
functional accuracy of each core

2. FPGA test bed

• Check for synthesisability of code

• Check for functional accuracy after synthesis and P&R

• Perform timing analysis

• Obtain rough estimates of resource utilization on FPGA

It is easy to run either test. The following subsections will describe
the procedure needed to run both types of tests. Each DSP core is
located in its own directory in the dsp directory. Each directory typ-
ically contains a tb_iverilog directory for simulations and tb_altera
directory for FPGA test beds, with a complete, end-to-end, test avail-
able found in the dsp/system_tb directory13. 13 If you’re playing with the DSP cores,

it’s worth ensuring that you haven’t
unintentionally broken anything by
running the dsp/system_tb test bench
prior to taking the time to synthesize
everything!

Running Simulations

1. Install iverilog and gtkwave

2. cd into the tb_iverilog directory for the core of interest, or the
system_tb directory to run a test of the entire dsp system.

For example:

$ cd langford/fw/dsp/HPF/tb_iverilog

3. From a terminal, run:

$ make test
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All necessary files will be generated and the simulation will run.

4. After the simulation is complete, gtkwave will launch with the
simulation results. You can view these results and compare them
against your expectations.

5. If you wish, you can modify the test bench by editing the tb_iverilog.v
file.

For example: git://langford/fw/dsp/HPF/tb_iverilog/tb_iverilog.v
You can repeat simulation after modifying the test bench by
restarting from step 3.

6. You can modify the DSP core by editing the DSP core file. For
example: dsp/HPF/HPF.v

You can repeat simulation after modifying the test bench by
restarting from step 3.

Figure 10 shows a screen capture of one such simulation.

Figure 10: Screencapture of
end-to-end DSP testbench
using iVerilog, found in the
dsp/system_tb directory.

FPGA Test beds

1. Download and install Quartus II 12.0 SP2.

2. Ensure that TalkBack is enabled. This will enable basic SignalTap
functionality14. 14 Follow these steps to enable TalkBack:

http://www.altera.com/support/kdb/solutions/rd06202008_3.html
3. Launch quartus. On Linux installations, Quartus II is installed to:

$PREFIX/quartus/bin/quartus

4. Power up the target FPGA board and connect your USB Blaster
Cable.

5. In Quartus, click File > Open Project.
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6. Open the tb_altera.qpf project file located in the tb_altera directory
of the DSP core of your choice.

For example: dsp/HPF/tb_altera/tb_altera.qpf

7. In Quartus, click Processing > Start Compilation. This will gener-
ate the design file. All timing and Once this is complete, you will
get a message informing you of such.

8. Click Tools > SignalTap II Logic Analyzer

9. Ensure that USB-Blaster is selected under Hardware and the target
FPGA is detected.

10. Click on the program button.

11. Once the device is programmed, click Processing > Run Analysis.
Captured data will be displayed in the Data tab.

Notes

• If during the synthesis for the FPGA test bed that you get a mes-
sage that a file is not available, its likely that it relies a file that is
generated by the makefile. Run make in the tb_iverilog directory.
See section on Running Simulations for more information.

• Some test benches include a variety of stimulus for simulation.
You’ll see different sections commented out - simply comment or
uncomment a block to enable a particular stimulus. If you have more than one stimulus

driving an input, you’ll get an error
informing you as much.• If you want to examine other signals with SignalTap, you can

do so by clicking on the Setup tab and double clicking on the
background of the table. You can select any number of signals to
add to your analysis. If the signal is not listed with the SignalTap
II: post-fitting filter applied, then it has been removed during
synthesis.





FPGA Programming

We’ve made it easy to program the Noctar FPGA. You’re going to re-
quire two things - a USB Blaster cable, which costs money, and a copy
of the Quartus II software, which is gratis on the Altera website15. 15 http://www.altera.com

How to program the FPGA

1. Apply power to the Phi device. You can do this either by inserting
this device into a computer with a PCIe slot and turning it on or
into a dummy PCIe slot.

2. Connect the 10 pin header of the JTAG programmer to JF1. Align
the red wire on the programmer cable to pin 1.

3. Connect the JTAG programmer’s USB cable to the JTAG server.

4. Launch Quartus II

5. In Quartus, click Tools > Programmer

6. Ensure that the reported hardware is USB-Blaster. If it does not,
plug in the the USB cable of the JTAG programmer, close the
Quartus Programmer and repeat step 6.

(a) (Optionally) If you click on «Auto-detect», it should recognize
the FPGA.

(b) If you do use Auto-detect to test the circuit, remember to
delete the FPGA and image - you don’t want anything there.

7. From the menu, click Edit > Add File

8. Browse and open your file (output_file.jic)

9. Enable Program/Configure and Verify for the EPCS16 device

10. Click Processing > Start

11. The yellow LED on the board will blink and turn on as the pro-
gram is downloaded.
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(a) When the programming is complete, the Quartus program will
indicate as such.

12. Turn off your computer. Note that you should do a cold shut
down to ensure the device enumerates properly - a reboot doesn’t
always do it.

13. Congratulations! You have successfully programmed the FPGA
It is now safe to remove power from the device. Next time the
device is powered on, the FPGA status LED (DF1) will come on
automatically16. 16 If the device doesn’t show up on

lspci, then either the image you burned
is no good, or you didn’t do a hard
power down of the card.

Figure 11: Quartus 12.0sp2

programming window after
successfully programming
FPGA.

Additional Notes

• You can program the device remotely, if you set up a JTAG server,
but this can be a little unwieldy.



Driver Implementation

This document outlines the considerations taken into the design and
implementation of the driver for the Noctar device. The goal is
to allow you to easily add features, modify, or debug, the Noctar

driver.
The files required to compile the driver are located in the git://langford_driver

directory. There are 4 files which are used to make the driver:

1. Makefile

Contains the rules to compile and load the driver and utilities, and
creates the initial character device.

2. langford.c

Main source file for the driver.

3. langford.h

Constants, include statements and other preprocessor macros for
the driver.

4. langford_ioctl.h

Contains all the constants for ioctl calls. Can be included by user
mode programs (e.g. langford_*util) too.

The Noctar device is represented on a Linux computer as a charac-
ter device. This device needs to be created prior to accessing Noc-
tar

17: 17 You can create this device using
mknod (look in /proc/devices for
major number) - see the langford_init
source for a script.

1. Run langford_init. This program parses your /proc/devices file
and automagically creates the character device.

2. View the kernel logs when the driver is loading. The driver will
display the exact command needed to created the character de-
vice18. 18 There’s a lot of useful information to

be found by looking at the dmesg file
when langford runs.3. Run make install in the langford_driver directory.
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Variable Naming

Confusion may arise from the notion of read or write and their use
in variable names. This is understandable - it arises from the per-
spective and context within which they are used. To illustrate, to a
user mode program, a file write is used to transmit data toward the
SDR and out into the real world. However, for Noctar

19, bus writes 19 Noctar is a SDR device with an
FPGA in bus mastering mode (to
perform DMA transfers)

actually move data from the real world into the computer, the ex-
act opposite direction as a software write. It’s difficult to maintain a
consistent variable naming convention that meets semantic meaning
and expectancy. To reduce the confusion, we now outline the variable
names used in the driver and which side they are used on.

Description

RX Variables in from the real world.

TX Variables out to the real world.

DMA Pointers (RX/TX based)

RX pRxDmaBuffs RxDmaBuffsBusAddr

TX pTxDmaBuffs TxDmaBuffsBusAddr

User mode IO handler (Software-centric)

RX cdev_read

TX cdev_write

DMA transfer thread (Software-centric)

RX dev_read_thread dev_read_task

TX dev_write_thread dev_write_task

Buffer for character device (Software-centric)

RX cdev_read_buff_mutex cdev_read_buff cdev_read_buff_start
cdev_read_buff_end

TX cdev_write_buff_mutex cdev_write_buff cdev_write_buff_start
cdev_write_buff_end

DMA constants (RX/TX based)

RX DMARXBUFFS DMARXDESCS DMARXDESCDELAY

TX DMATXBUFFS DMATXDESCS DMATXDESCDELAY
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BAR constants (FPGA-centric)

RX WRCSR* WRDESC*

TX RDCSR* RDDESC*

Driver Initialization Flow

When the driver is loaded, many events happen. In particular, these
functions will be called in the following order:

1. driver_initial

This function is called when insmod is called. This function per-
forms the following tasks in the following order:

(a) Registers the driver with the PCI subsystem

(b) Registers the character device

2. driver_probe

This function is run when a new PCI device is discovered on the
system which may be the Noctar device. This function checks
the device for compatibility and initializes it. Specifically, this
function performs the following tasks in the following order:

(a) Enables the device via the PCI subsystem.

(b) Checks device version (in PCI configuration space) for compat-
ibility.

(c) Maps BAR regions to pointers accessible form kernel space.

(d) Discovers and sets up DMA settings with the kernel.

(e) Initialize the SDR peripherals (ADC, DAC) and put them in
low power mode.

At this point, the driver is completely loaded and the user can inter-
act with the device via character device reads, writes or ioctl calls.
During removal;

1. driver_remove

This function is executed when a the Noctar device is removed
or if the driver is unloaded. This function undoes all the tasks
performed in driver_probe.

2. driver_exit

This function is called when the driver is unloaded. This function
undoes all the tasks performed in driver_initial.
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IO Flow

When the driver has completely loaded, it goes away into the back-
ground, waiting for the character device file to be opened. When the
device is opened, the driver sets up the computer for DMA transfers.
When all IO has complete and the file is closed, DMA transfers are
stopped. Specifically, when the character device is being opened, the
following tasks are completed by cdev_open:

1. Allocate DMA memory buffers

2. Calculate and write address translation table to the FPGA

3. Allocate character device memory buffer

4. Power on ADC and DAC

5. Spawn DMA read and write device threads

The file close function (cdev_release) undoes all the tasks completed
by cdev_open.

After the file is open, various IO can take place. Reads and writes
interacts with data which is shared between the kernel space driver
and user space application. Because everything is multi threaded,
these tasks happen concurrently.

We illustrate the interaction process between the user program,
kernel module and FPGA for the Receive and Transmit sides in Fig-
ures 12 and 13

20. 20 This is really important - because
everything happens at once, you can’t
immediately rely on synchronous
patterns.

Figure 12: Rx Data flow

Figure 13: TX Dataflow

Character Device Data Format

Due to asymmetric PCIe DMA transfer bandwidths (see FPGA Sys-
tem Description for explanation), the data format for RX is different
than TX. Both are designed to take advantage of as much of the avail-
able bandwidth as possible.
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Receive Data (High Frequency Branch)

Rx data are provided in IQ pairs. Each IQ pair is 32 bits, with the I
and Q components represented by two 16 bit signed integers. Specif-
ically, the format for RX (reading from the /dev/langford device)
on the high frequency RX stage is represented in Table 5. To read
this data inside GNU radio, you can use a flow chart similar to that
shown in Figure 5.

Position 0 1 2 3 4 5 6 7 8

Data I[0] Q[0] I[1] Q[1] etc Table 5: RX HF data structure

Figure 14: RX HF flow structure

Receive Data (Base band Branch)

We receive base band shorts by interleaving ADC samples indepen-
dently triggered on the positive and negative clock edges. We don’t
presently carry out base band DSP. To ensure ADC interleaving, we
use the Langford ADC utility;

$langford_adc_util /dev/langford A ClkSel 0

$langford_adc_util /dev/langford B ClkSel 1

The data and flow structure for reading base band Rx data are
shown in Table 6 and Figure 15.

Position 0 1 2 3 4 5 6

Data P[0] N[0] P[1] P[1] P[2] N[2] etc

Table 6: RX BB data structure

Figure 15: RX BB flow structure
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Transmission Data (High Frequency Branch)

TX data are provided in IQ pairs. Each IQ pair is 16 bits. I is repre-
sented as a 8 bit signed integer. Following I is Q also represented as a
8 bit singed integer. The data structure for high frequency transmis-
sion is shown in Table 7, with the flow chart shown in Figure 16.

Position 0 1 2 3 4 5 6

Data I[0] Q[0] I[1] Q[1] I[2] Q[2] etc Table 7: TX HF data structure

Figure 16: Tx HF flow structure

Transmission Data (Low Frequency Branch)

For low frequency output, we only use one end of the IQ pair - the
other end is essentially left dangling, although the ports have been
exposed As it happens, we use the real part, so base band transmis- You can access the DAC output

by probing the ports on the
top left corner of the shielded
section located just to the left of
the DAC.

sion, using the structure in Figure is as straightforward as building
the graph shown in Figure 17.

Position 0 1 2 3 4 5 6

Data I[0] I[1] I[2] I[3] I[4] I[5] etc

Table 8: TX BB data structure

Figure 17: TX BB flow structure



Appendix I: Mechanical Drawings





Appendix I: Pin Descriptions

For the engineers, masochistic, or curious, this section exhaustively
lists all the options you can change with langford. Consider this the
hardware API that allows you to manipulate the data that Noctar

collects21. 21 If you’re not sure how these param-
eters affect RF performance, see the
system overview section to see exactly
how they’ll effect signal quality.Pin Name

Allowed Values Description

N21at0, N22at0

0-255 RX and TX high frequency variable gain setting respectively.
0 = 0 V (minimum gain) and 255 = 5 V (maximum gain), other
values are linear interpolated.

N3GAIN

0-255 RX low frequency variable gain setting. 0 = 0 V (minimum
gain) and 255 = 1 V (maximum gain), other values are linear inter-
polated.

N61CE, N62CE

0,1 Chip Enable pin of serial interface for RX and TX frequency
synthesizer respectively.

N61DATA, N62DATA

0,1 Data pin of serial interface for RX and TX frequency synthesizer
respectively.

N61CLK, N62CLK

0,1 Clock pin of serial interface for RX and TX frequency synthesizer
respectively.
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N61LE, N62LE

0,1 Latch Enable pin of serial interface for RX and TX frequency
synthesizer respectively.

N61MUXOUT, N62MUXOUT

0,1 Multiplexor output pin of serial interface for RX and TX fre-
quency synthesizer respectively.

N61LD, N62LD

0,1 Lock detect pin of serial interface for RX and TX frequency syn-
thesizer respectively

N3ENB

0,1 Enable low frequency amplifier.

N3HILO

0,1 Enable High or Low Gain stages (Low gain = -4.5..43.5dB, High
gain = 7.5..55.5dB). Overall gain determined in conjunction with
N3GAIN.

NASRxA, NASTxA

0,1 Control pin for RF switch. This pin controls the A pin of the
switches. The B pin is always guaranteed to take the logical com-
pliment of the A pin.

N7CLK

0,1 Clock pin of the serial interface for the differential ADC VGA.

N7CS

0,1 Chip select pin of the serial interface for the differential ADC
VGA.

N7SDI

0,1 Serial data to the serial interface for the the differential ADC
VGA.
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N7SDO

0,1 Serial data from the serial interface for the the differential ADC
VGA.

DACIQSel

0,1 IQ framing pin for the DAC. Used for single port mode.

DACReset

0,1 Reset pin for the DAC. Used also to enable pin mode.

DACCSB

0,1 Enable mix mode for the DAC. Used also as the chip select pin
for the DAC’s serial interface.

DACSDIO

0,1 Enable unsigned binary data format for the DAC. By default, the
data format is signed binary. Used also as the data pin to/from the
DAC’s serial interface.

DACSClk

0,1 Enable single port mode for the DAC. By default, dual port
mode is enabled. Used also as the clock pin for the DAC’s serial
interface.

DACSDO

0,1 Power down the DAC. Used also as the data pin from the DAC’s
serial interface.

ADCAPD, ADCBPD

0,1 Power down the ADC.

ADCASClk, ADCBSClk

0,1 Enable signed binary data format for the ADC. By default, the
data format is unsigned binary. Used also as the clock pin for the
ADC’s serial interface.
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ADCASDIO, ADCBSDIO

0,1 Enable LVDS outputs for the ADC. By default, the data format
is CMOS. Used also as the data pin to/from the ADC’s serial
interface.

ADCAnCS, ADCBnCS

0,1 Enable pin mode for the ADC. Used also as the chip select pin
for the ADC’s serial interface.

RXPhase, TXPhase

0-(232 − 1) Phase increment for the RX and TX NCO respectively.
fNCO = Phase increment

232 ∗ fsr,ADC, where fsr,ADC = 125MHz.

RxDecEn, TxIntEn

0,1 Enable RX decimation and TX interpolation respectively. To
reduce bus bandwidth, you can choose to perform decimation and
interpolation. Each bit enables a decimation or interpolation state.
For example, 0x03 enables 2 stages. For another example, 0x01 is
the same as 0x08.

RXRevFreq, TXRevFreq

0,1 Reverse (negate) DDC (digital down conversion) and DUC (digi-
tal up conversion) frequency.

RXDspEn, TXDspEn

0,1 Enable the entire RX or TX DSP chain respectively.

NRXTALSEL

0,1 Crystal select pin of the clock distribution IC. This determines
whether the internal or external reference is used. If you opt to use
the external reference, ensure that it is a 20MHz reference.

NRVCOSEL

0,1 Bypass the clock distribution IC. If you want to directly drive the
frequency dividers from reference, this is the way to do it...



Appendix II: GPIO Address Offsets

The GPIO (general purpose IO) pins are used to provide IO function-
ality to both control signals within the FPGA as well as other board
level peripherals. For example, the frequency for digital down/up
conversion and the pins for the serial interface for the ADC VGA
driver is set this way.

GPIO pins are grouped into 32 bit registers, all of which reside
on BAR0 of the PCIe HIP. In the Qsys design, each 32 bit register is
implemented as a PIO device. The PIO device is an Altera IP which
can be found under Peripherals > Microcontroller Peripherals in
the Component Library. Currently, there are 6 32 bit registers. This
following subsections summarizes the assignment of GPIO pins in
the Noctar system.

Bit Assignment

7:0 N21at0
15:8 N22at0

23:16 N3GAIN

Table 9: PIO0 - Output - Ad-
dress offset: 0x00008000 - Ana-
log pin control pins.
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Bit Assignment

0 N61CE
1 N61DATA
2 N61CLK
3 N61LE
4 N62CE
5 N62DATA
6 N62CLK
7 N62LE
8 N3ENB
9 N3HILO
10 NASRxA
11 NASTxA
12 N7CLK
13 N7CS
14 N7SDI
15 DACIQSel
16 DACReset
17 DACCSB
18 DACSDIO
19 DACSClk
20 ADCAnOE
21 ADCAPD
22 ADCASClk
23 ADCASDIO
24 ADCACS
25 ADCBnOE
26 ADCBPD
27 ADCBSClk
28 ADCBSDIO
30 DACSDO

Table 10: PIO1 - Output - Ad-
dress offset: 0x00008100 - Physi-
cal output pins.

Bit Assignment

0 N61MUXOUT
1 N61LD
2 N62MUXOUT
3 N62LD
4 N7SDO
5 USER GPIO #1

6 USER GPIO #2

7 USER GPIO #3

8 USER GPIO #4

9 USER GPIO #5

Table 11: PIO2 - Input - Ad-
dress offset: 0x00008200 -
Physical input pins, header
GPIO
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Bit Assignment

31:0 RXPhase Table 12: PIO3 - Output - Ad-
dress offset: 0x00008300 - Phase
increment for rx NCO

Bit Assignment

31:0 TXPhase Table 13: PIO4 - Output - Ad-
dress offset: 0x00008400 - Phase
increment for tx NCO

Bit Assignment

7:0 RXDecEn
15:8 TXIntEn
16 RXRevFreq
17 TXRevFreq
18 RxDspEn
19 TxDspEn
20 NRXTALSEL
21 NRVCOSEL
22 RxFifoClr
23 TxFifoClr
24 RxIsSigned
25 TxIsSigned
26 USER GPIO #1

27 USER GPIO #2

28 USER GPIO #3

29 USER GPIO #4

30 USER GPIO #5

Table 14: PIO5 - Output - Ad-
dress offset: 0x00008500 - DSP,
clock control, header GPIO





Epilogue

«Take chances! Make mistakes22! Get messy!» 22 Per Vices believes in the value of
mistakes as research experience. We
encourage, whenever possible, that
you try and limit your mistakes to the
(mostly) reversible kind. However, we
also appreciate those times when you
know better, but do it anyways.

Ms. Frizzle
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